
 2
Drained and undrained stability of an embankment

In this chapter the construction of an embankment on clay is simulated. The clay will first be considered a
drained material and then an undrained material. For both cases the factor of safety will be determined. This
would for instance give an indication of both the long term and short term stability of the embankment.
Objectives

• Modelling Drained and Undrained soil behaviour.
• Changing material sets during the calculation.
• Calculating a factor of safety.
Geometry

Figure 28 (on page 39) shows the layout of an embankment . The embankment is 4 m high and the crest of the
embankment has a width of 2.0 m. The groundwater level is just below surface, but to simplify the problem it
will be defined at ground level.
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Figure 28: Geometry of the project

2.1 Create new project
To create a new project, follow these steps:
1. Start the Input program and select Start a new project from the Quick start dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-Noded).

PLAXIS 39 Tutorial Manual 2D



4. Set the model dimensions to: xmin = 0 m, xmax = 50 m, ymin = -6 m and ymax = 4 m.
5. Keep the default values for units, constants and the general parameters and click OK to close the Project

properties window.

2.2 Define the soil stratigraphy
The subsoil profile consists of a single clay layer extending until large depth. Since we are only interested in the
stability of the embankment it is not necessary to model the clay layer until very large depth; the model has to be
deep enough to allow the failure mechanism to form. Please note that for a deformation analysis a deeper model
may be required as deformations due to the construction of the embankment will still occur at considerable
depth.
To define the soil stratigraphy:
1. Click the Create borehole button  and create a borehole at x = 0.

The Modify soil layers window pops up as shown in Figure 29 (on page 40).
2. Add a single soil layer from Top = 0 to Bottom = -6.
3. Keep the Head for this borehole to 0. Hence, the groundwater level coincides with ground level.

Figure 29: The soil stratigraphy in the Modify soil layers window
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2.3 Create and assign material data sets
For this project three material sets have to be defined. One material to represent the sand of which the
embankment will be constructed and two materials representing the subsoil: a drained and an undrained
material set representing the clay in long term and short term conditions.
Table 3: Material properties of the soil layer

Parameter Name Embankment Clay layer Unit

General

Soil model - Hardening
soil Hardening soil -

Type of material behaviour - Drained Drained -
Unsaturated unit weight γunsat 16 13 kN/m3

Saturated unit weight γsat 16 13 kN/m3

Mechanical

Secant stiffness in standard drained
triaxial test E50

ref 15·103 5,600 kN/m2

Tangent stiffness for primary
oedometer loading Eoed

ref 15·103 5,000 kN/m2

Unloading / reloading stiffness Eur
ref 45·103 20·103 kN/m2

Power for stress-level dependency
of stiffness m 0.5 1.0 -

Cohesion c'ref 3 10 kN/m2

Friction angle φ' 30 25 °

Initial

K0-determination - Automatic Automatic -
Overconsolidation ratio OCR 1.0 1.2 -

1. Select the Show materials button  so that the Materials sets window shows up.
2. Using the New button define the two material sets as defined in the Table 3 (on page 41) .
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3. In order to create the undrained material set for the clay layer select the drained material in the Material
sets window and click the Copy button to duplicate the material set. In the copied material set, change the
name and set the Drainage type to Undrained (A).

4. Assign the material set representing the drained clay to the subsoil.

2.4 Create the embankment
We will now create the embankment. This is done by defining a soil polygon after which the polygon gets
assigned the material set representing the embankment material.
1. Go to Structures mode .
2. From the tools side bar select the Create soil polygon option  and then from the small popup button

menu that appears select the Create soil polygon  option again.
3. Now draw a polygon starting from (x y) = (14 0) continuing to (22 4), (24 4) and finally (36 0).
4. Now assign the embankment material to the polygon. This can either be done by opening the Material sets

window and then drag and drop the material set onto the polygon, or by selecting the polygon and then in the
Selection explorer set the Material option of the soil polygon to the embankment material.

2.5 Generate the mesh
1. Proceed to the Mesh mode .
2. Click the Generate mesh button  to generate the mesh.

The Mesh options window appears.
3. Select the Fine option in the Element distribution list and generate the mesh.
4. Click the View mesh button  to view the mesh and the generated mesh is shown in Figure 30 (on page

42).

Figure 30: The generated mesh

5. Select the Close button on the top left of the Output program to close the mesh view.
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2.6 Define and perform the calculation

The embankment construction is done in a single stage here, as we're only interested in the stability. Note that
for settlement predictions it is better to divide the construction of the embankment in multiple phases, if
necessary with periods of consolidation in between. The embankment construction has to be done both on
drained and undrained subsoil, so a total of three calculation phases have to be defined: the initial phase and two
construction phases.

2.6.1 Initial phase: Initial conditions

In the initial situation the embankment is not present yet. Since the subsoil consists of only 1 layer with a
horizontal ground level the K0 procedure can be used to generate the initial stresses. As this is the default
option, no changes have to be made to the initial phase. The model in the initial phase is shown in Figure 31 (on
page 43).

Figure 31: Configuration of the initial phase

2.6.2 Phase 1: Embankment construction on drained subsoil

1. Click the Add phase button  to create a new phase .
In the new phase the Calculation Type > Plastic analysis and the Loading type > Staged construction are
used as a default.

2. Right-click on the embankment and from the popup menu select the Activate option to activate the soil
representing the embankment. The model of phase 1 is shown in Figure 32 (on page 43).

Figure 32: Configuration of phase 1
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2.6.3 Phase 2: Embankment construction on undrained subsoil

In this second calculation phase the same embankment will be constructed, by now under the assumption of
undrained behaviour of the subsoil. This implies that the material set of the subsoil must be changed, but also
that this construction phase must start from the initial phase as it is an alternative calculation for phase 1 rather
than a continuation of phase 1.
1. In the Phase explorer select the Initial phase and then create a new phase using the Add phase button .

Because the initial phase was the selected phase the newly created phase 2 will start from the initial phase. In
case by mistake phase 2 does start from phase 1, this can be changed double-clicking on Phase 2 in the
Selection explorer so that the Phases window opens. In the General section now set the option Start from
phase to the initial phase and close the Phases window again.

2. Now the soil behaviour of the subsoil must be changed to undrained by assigning the undrained material set
to the subsoil. There are several ways to do this:
From the navigation side bar select the Show materials button . From the Material sets window that
opens drag and drop the material set for undrained clay on the subsoil.
or
Right-click on the subsoil and from the popup menu(s) that open consecutively select the options Soil ( ),
Soil ( ), Set material and finally the material representing the undrained subsoil to assign it.
or
Select the subsoil and in the Selection explorer change the Material under the Soil object for the material
representing the undrained subsoil.

3. Finally, activate the embankment, and the resulting model is shown in Figure 33 (on page 44).

Figure 33: Configuration of phase 2

2.6.4 Calculate

Before starting the calculation it's recommended to choose some nodes or stress points to later evaluate the
results in for instance load-displacement or stress-strain curves. In this project we will select a point halfway the
left hand side slope to later evaluate the factor of safety.
1. Click the Select points for curves button  on the navigation side bar.
2. Select a Node halfway the left hand side slope, hence around (x y) = (18 2).
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3. Click the Update button on the top left to close the Output program and store the selected point.
4. Click the Calculate button  to start the calculation.

2.7 Results

1. After the calculation ended, select the first phase and click the View calculations results button .
The Output program now opens showing the deformed mesh after the construction of the embankment on
the drained subsoil.

2. From the dropdown list on the button bar at the top now choose to see the results for Phase 2. Now the
deformed mesh after construction of the embankment on undrained subsoil is shown.
Figure 34 (on page 45) shows the deformed mesh for both phases. In case of the drained subsoil the
embankment settles everywhere, but in case of the undrained subsoil the embankment settles in the middle
but heaves near the toes. This makes perfect sense: the subsoil is now undrained and because of that there
can be no volume change. Hence, if the subsoil settles in the middle due to the weight of the embankment it
must heave somewhere else, typically just next to the embankment.

Figure 34: Deformed mesh after phase 1 (top) and phase 2 (bottom)

It can also be seen that in case of the undrained subsoil the embankment seems to widen leading to a larger
settlement at the top of the embankment. This is not immediately obvious and it will be discussed in more
detail after performing a factor of safety analysis.

3. From the Stresses menu select the option Pore pressures and then pexcess. This will show the excess pore
pressures due to the undrained loading of the subsoil. By default the pore pressures are shown as iso-
shadings but with the buttons  and  from the horizontal button bar at the top it is possible to see the
principal directions of the pore pressures, either for all or a reduced number of stress points.
Figure 35 (on page 46) shows that excess pore pressures have developed due to the construction of the
embankment. The highest excess pore pressures are of course directly underneath the embankment, but also
on either side of the toes of the embankment some excess pore pressures occur.
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Figure 35: Excess pore pressures after construction on undrained subsoil

4. After viewing the results, close the Output program and return to the Input program.

2.8 Safety analysis
In the design of an embankment it is important to consider not only the settlements, but also the stability in
terms of a factor of safety. It could be seen that the settlements are different for the construction of an
embankment on drained or undrained subsoil and so it would be interesting to evaluate a global safety factor for
both cases.
In structural engineering, the safety factor is usually defined as the ratio of the collapse load to the working load.
For soil structures, however, this definition is not always useful. For embankments, for example, most of the
loading is caused by soil weight and an increase in soil weight would not necessarily lead to collapse. Indeed, a
slope of purely frictional soil will not fail in a test in which the self weight of the soil is increased (like in a
centrifuge test). A more appropriate definition of the factor of safety is therefore:

Safety factor =
Smaximum available

Sneeded for equilibrium

Where S represents the shear strength. The ratio of the true strength to the computed minimum strength
required for equilibrium (hence, the mobilized strength) is the safety factor that is conventionally used in soil
mechanics. For soil models using the standard Coulomb failure condition, the safety factor is obtained as:

Safety factor =
c − σntan(φ)

cr − σntan(φn)

Where c and φ are the input strength parameters and σn is the actual normal stress component.
The parameters cr and φr are reduced strength parameters that are just large enough to maintain equilibrium.
The principle described above is the basis of the method of Safety that can be used in PLAXIS 2D to calculate a
global safety factor. In this approach the cohesion and the tangent of the friction angle are reduced in the same
proportion:

c
cr

= tan(φ)
tan(φr )

= ΣMsf

The reduction of strength parameters is controlled by a multiplier called ΣMsf that is increased step-by-step
until failure occurs. The safety factor is then defined as the value of ΣMsf at failure, provided that at failure a
more or less constant value is obtained for a number of successive load steps with ongoing deformations.
Note that for soil models that do no use the Coulomb failure criterion the concept of strength reduction remains
the same, but with reduction of strength parameters specific to that soil model.
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The Safety calculation option is available in the Calculation type drop-down menu in the General section of the
Phases window. If the Safety option is selected the Loading input on the Parameters tabsheet is automatically
set to Incremental multipliers, this means that the multiplier ΣMsf will be incremented until failure occurs. The
other option for the Loading input is Target-ΣMsf, which means the multiplier ΣMsf will only increase until the
specified target value and not until failure. However, this latter option is not used here.
To calculate the global safety factor for the road embankment for both cases, follow these steps:
1. Select Phase 1 in the Phases explorer.
2. Add a new calculation phase. 
3. Double-click on the new phase to open the Phases window.
4. In the Phases window the selected phase is automatically selected in the Start from phase_1 drop-down

menu.
5. In the General subtree, set the Calculation type as Safety  from the drop down menu.
6. The Incremental multipliers option  is already selected in the Loading input box. The first increment of

the multiplier that controls the strength reduction process, Msf, is set to 0.1.
7. In order to exclude existing deformations from the resulting failure mechanism, select the Reset

displacements to zero option in the Deformation control parameters subtree.
8. The first safety calculation has now been defined.
9. Follow the same steps to create a new calculation phase that analyses the stability at the end of construction

of the embankment on undrained subsoil.
10. Click the Calculate button  to start the calculation .

The phases explorer window displaying the safety calculation is shown in Figure 36 (on page 47).

Figure 36: Phases explorer displaying the Safety calculation phases

Note:

Note that for a Safety phase the option Use pressures from the previous phase  in the Pore pressure
calculation type drop-down menu is automatically selected and grayed out indicating that this option cannot be
changed. A Safety calculation always uses the same pore pressures as the phase for which the safety factor has
to be calculated.

Note:

The default value of Max steps in a Safety calculation is 100. In contrast to a Staged construction calculation,
the specified number of steps is always fully executed. In most Safety calculations, 100 steps are sufficient to
arrive at a state of failure. If not, the number of steps can be increased to a maximum of 1000.

Drained and undrained stability of an embankment
Safety analysis

PLAXIS 47 Tutorial Manual 2D



For most Safety analyses Msf = 0.1 is an adequate first step to start up the process. During the calculation
process, the development of the total multiplier for the strength reduction, ΣMsf, is automatically controlled by
the load advancement procedure.

2.8.1 Evaluation of safety analysis results

Due to the ongoing reduction of the soil strength, additional displacements are generated during a Safety
calculation. The resulting total displacements do not have a physical meaning as they depend on the amount of
load steps that was applied: more load steps means the calculation would push further into failure thus
generating larger displacement while in reality a failing embankment would re-establish a new equilibrium with
limited deformations. However, the incremental displacements in the final step (at failure) are very useful as
they give an indication of the likely failure mechanism. The incremental displacements are the change of
displacement per load increment. Typically this is a very small value as the load increments are small, but in case
of failure the failure zone only needs a very small change of load to generate large changes of displacements,
hence the failure zone then has large incremental displacement whereas anywhere else in the model the
incremental displacements should be small.
In order to view the mechanism for the embankment on drained subsoil:
1. Select Phase 3, that is the Safety phase following on Phase 1, and click the View calculation results button

.
2. In the Output program select the menu Deformations > Incremental displacements > |Δu|.

Figure 37: Shadings of the displacement increments indicating the most applicable failure mechanism of the
embankment after drained construction

The resulting plot shown in Figure 37 (on page 48) gives a good impression of the failure mechanisms. The
magnitude of the displacement increments is not relevant. From the results it can be seen that the slope on the
left side of the embankment fails with a classical slip surface .
By choosing phase 4 from the drop down list at the toolbar the failure mechanism for the embankment
constructed on undrained subsoil can be evaluated. The failure mechanism is no longer limited to just the
embankment, but is in fact mostly a failure of the subsoil underneath the embankment. This also explains the
widening of the embankment at the base as was observed earlier: the soil underneath the embankment fails and
moves horizontally away from the center of the embankment shown in Figure 38 (on page 49).
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Figure 38: Shadings of the displacement increments indicating the most applicable failure mechanism of the
embankment after undrained construction

The safety factor can be obtained from the Calculation info option of the Project menu. The Multipliers
tabsheet of the Calculation information window represents the actual values of the load multipliers. The value
of ΣMsf represents the safety factor, provided that this value is indeed more or less constant during the previous
few steps.
The best way to evaluate the safety factor, however, is to plot a curve in which the parameter ΣMsf is plotted
against the displacements of a certain node. Although the displacements are not relevant, they indicate whether
or not a failure mechanism has developed.
In order to evaluate the safety factors for the three situations in this way, follow these steps:
1. Click the Curves manager button  in the toolbar.
2. Click New in the Charts tabsheet.
3. In the Curve generation window, use from the dropdown list the previously selected Node for the x-axis.

Select Deformations > Total displacements > |u|.
4. For the y-axis, select Project > Multipliers > ΣMsf. The Safety phases are considered in the chart.
5. Press OK to close the window and generate the chart.
6. Right-click on the chart and select the Settings option in the appearing menu. The Settings window pops up.
7. In the tabsheet corresponding to the curve click the Phases button.
8. In the Select phases window select only Phase 3 as shown in Figure 39 (on page 49):

Figure 39: The Select phases window
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9. Click OK to close the Select phases window.
10. In the Settings window change the titles of the curve in the corresponding tabsheet.
11. Click the Add curve button and select the From current project option in the appearing menu. Define the

curve for the phase 4 by following the same steps as described for phase 3.
12. In the Chart tabsheet shown in Figure 40 (on page 50), set the scaling of the x-axis to Manual and set the

value of Maximum to 0.5:

Figure 40: The Chart tabsheet in the Settings window

13. Click Apply to update the chart according to the changes made and click OK to close the Settings window.
14. C
15. The plot is shown as follows in Figure 41 (on page 50):

Figure 41: Evaluation of safety factor
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The maximum displacements plotted are not relevant. It can be seen that for both curves a more or less constant
value of ΣMsf is obtained. Hovering the mouse cursor over a point on the curves, a box shows up with the exact
value of ΣMsf as well as the calculation phase. With the latter it can be determined that the upper curve with a
factor of safety of 1.8 is phase 3, hence the embankment on drained soil. Similarly the lower curve with a factor
of safety of 1.4 is phase 4, the embankment on undrained soil.
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